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BP-BASSENSORSMKII user's guide

The Building Automation Systems Sensors MKII BoosterPack™ Plug-in  Module kit (BP-
BASSENSORSMKII) is an easy-to-use module for adding digital sensors to your LaunchPad™
development kit design. SimpleLink™ microcontroller (MCU) LaunchPad development kit developers can
use this BoosterPack plug-in module to start developing sensor applications using the onboard
temperature, humidity, ambient light, and magnetic flux sensors, as well as the included inertial
measurement unit (IMU) and magnetometer.
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Figure 1. BP-BASSENSORSMKII BoosterPack Plug-in Module
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Trademarks
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trademarks of Texas Instruments.

ARM, Keil, uVision are registered trademarks of ARM Ltd.

Bluetooth is a registered trademark of Bluetooth SIG.

IAR Embedded Workbench, C-SPY are registered trademarks of IAR Systems AB.

Bosch is a registered trademark of Robert Bosch LLC..

Wi-Fi is a registered trademark of Wi-Fi Alliance.

BoosterPack is a trademark of others.
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Getting Started

Introduction

The Building Automation Systems Sensors MKII BoosterPack Plug-in Module kit (BP-BASSENSORSMKII)
is an easy-to-use module for adding digital sensors to the LaunchPad development kit design. For these
SimpleLink MCU LaunchPad development kits, engineers can use this BoosterPack plug-in module to
start developing sensor applications using the onboard temperature, humidity, ambient light, and magnetic
flux sensors, as well as the included inertial measurement unit (IMU) and magnetometer.

Key Features

» High-Accuracy Temperature Sensor (TMP117)

» Combined Temperature and Humidity Sensor (HDC2080)

* Ambient Light Sensor (OPT3001)

» Hall Effect Sensor (DRV5055-Q1)

+ Bosch BMI160 Inertial measurement Unit, and BMM150 Magnetometer
*  Works With Tl LaunchPad Development Kits

What's Included

Kit Contents
+ 1x BP-BASSENSORSMKII BoosterPack plug-in module
« 1x 3" Breakout Ribbon Cable

Next Steps: Looking Into the Provided Code

The next steps after reviewing the EVM features are to open an integrated development environment
(IDE) and start looking at the code examples. Section 3 describes the example projects available for the
user to understand the provided software.
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Figure 2 shows an overview of the BoosterPack plug-in module.
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Figure 2. BP-BASSENSORSMKII Overview
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2.1 Hardware Features

211 BoosterPack™ Plug-in Module Pinout
Figure 3 shows the pinout of the BoosterPack plug-in module.

O Pin aligns with BoosterPack pinout standard.
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Figure 3. BoosterPack™ Plug-In Module Pinout

The Building Automation Systems Sensors MKII BoosterPack plug-in module adheres to the 40-pin
LaunchPad development kit and BoosterPack plug-in module pinout standard. A standard was created to
aid compatibility between LaunchPad development kits and BoosterPack plug-in modules across the Tl
ecosystem.

The 40-pin standard on the BP-BASSENSORSMKII is compatible with the 20-pin standard that is used by
other LaunchPad development kits like the MSP-EXP430G2 LaunchPad development kit. This
compatibility allows for 40-pin BoosterPack plug-in modules to be used with 20-pin LaunchPad
development kits.

The BP-BASSENSORSMKII BoosterPack plug-in module has both male and female headers to support
stacking on top. The user must carefully consider stacking other BoosterPack plug-in modules near the
BASSensors MKII BoosterPack plug-in module as heat, shade, and electromagnetic fields can adversely
affect the sensors readings.

For more information on EVM compatibility with Tl LaunchPad development kits, refer to
www.ti.com/launchpad.

2.1.2 12C Addresses

Device 7 bit Address Hex (7 bit)
OPT3001 1000100 44
TMP117 1001000 48
HDC2080 1000000 40
BME150 0001101 13
BME160 1101001 69
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213

TI OPT3001 Light Sensor

The OPT3001 is a digital ambient light sensor (ALS) that measures the intensity of light as visible by the
human eye. Covering the sensor with a finger or shining a flashlight on it changes the output of the
OPT3001. The digital output is reported over an I°C- and System Management Bus (SMBus)-compatible,
2-wire serial interface. The reference designator for the OPT3001 is U2. Table 1 lists the pin connections
of the OPT3001.

For more information on the OPT3001 light sensor, refer to the OPT3001 product folder.

Table 1. OPT3001 Pinout

™ =i
J1.90 I2C SCL
J1.10® I2C SDA
J1.27 OPT3001 V+ Supply Pin
J1.25 OPT3001 INT Pin
M 12C Pins are shared amongst the TMP117, HDC2080, BMI160, and

OPT3001.

TI TMP117 Temperature Sensor

The TMP117 is a 16-bit digital local temperature sensor that measures the ambient temperature or the
temperature of an object in direct contact. Despite being a contact sensor, the sensitivity and accuracy of
the TMP117 is high enough to detect a change in temperature from a hand placed near the sensor. The
digital output is reported over an I°C- and SMBus-compatible, 2-wire serial interface. The reference
designator for the TMP117 is U6. Table 2 lists the pin connections of the TMP117.

In order to use the TMP117, the included ribbon cable must be connected. The metal contacts of the
cable must face down in the connector to make electrical contact. The black tab on the cable should be
face up.

For more information on the TMP117 temperature sensor, refer to the TMP117 product folder.

Table 2. TMP117 Pinout

™ =i
e Pin Function
J1.90 I)C SCL
J1.10M I)C SDA
J1.28 TMP117 V+ Supply Pin
J1.26 TMP117 ALERT Pin
M 12C Pins are shared amongst TMP117, HDC2080, BMI160, and

OPT3001.

TI HDC2080 Humidity Sensor

The TI HDC2080 is an integrated temperature and humidity sensor that measures ambient temperature
and relative humidity in RH%. The sensor can detect moisture in the surrounding environment as it
saturates the polymer sensing element on top side of the device. The digital output is reported over an
[*C- and SMBus-compatible 2-wire serial interface. The reference designator for the HDC2080 is U3.
Table 3 lists the pin connections of the HDC2080. Note that Pin J1.28 must drive a Logic Low or zero to
enable gate Q2 and power HDC2080.

For more information on the HDC2080 humidity sensor, refer to the HDC2080 product folder.
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Table 3. HDC2080 Pinout

™ =i
J1.90 I)C SCL
J1.10M I)C SDA
1.6 Enable HDC2080 3.3V Supply
(Inverted)
J1.23 HDC2080 INT Pin
M 12C Pins are shared amongst TMP117, HDC2080, BMI160, and

OPT3001.

2.1.6 TI DRV5055-Q1 Hall Effect Sensor

The TI DRV5055-Q1 Hall Effect sensor measures the strength of magnetic fields in one axis. Placing a
magnet near the sensor increases the sensor output. The output of the sensor is an analog voltage which
must be sampled by an ADC and converted to milliTesla. The reference designator for the DRV5055-Q1 is
U4. Table 4 lists the pin connections of the DRV5055-Q1. Note that Pin J1.24 must drive a Logic Low or
zero to enable gate Q1 and power DRV5055.

For more information on the DRV5055-Q1 hall effect sensor, refer to the DRV5055-Q1 product folder.

Table 4. DRV5055-Q1 Pinout

BoosterPack™ Plug-in Module . .
Header Connection A s
Ji1.2 DRV5055-Q1 Analog Output
Enable DRV5055-Q1 3.3-V Supply
Ji1.24
(Inverted)

21.7 Bosch® BMI160 Inertial Measurement Sensor

The Bosch BMI160 inertial measurement unit is a 6-axis digital accelerometer and gyroscope sensor that
measures gravitational forces exerted on the device, as well as the speed of rotation in degrees per
second. The BMI160 can synchronize its own accelerometer and gyroscope data as well as with an
external device such as a geomagnetic sensor. Rotating the board about its axis increases the gyroscope
output of the sensor, and changing the orientation of the board with respect to the earth changes it
accelerometer output. The BMI160 has a secondary I°C interface for connecting additional Bosch sensors
such as the BMM150 geomagnetic sensor. The digital output of both sensors is reported over an I1°C- and
SMBus-compatible 2-wire serial interface. The reference designator for The BMI160 is U1.

More information on The BMI160 inertial measurement unit can be found at https://www.bosch-
sensortec.com/products/motion-sensors/imus/bmi160.html.

Table 5. BMI160 Pinout

™ =i
J1.90 I2C SCL
J1.10M I2C SDA
J1.5 BMI160 INT1
J2.18 BMI160 INT 2
M 12C Pins are shared amongst TMP117, HDC2080, BMI160, and
OPT3001.
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2.1.8 Bosch BMM150 Geomagnetic Sensor

The Bosch BMM150 geomagnetic sensor is a 3-axis digital magnetometer sensor that measures the
strength of the magnetic fields in microtesla for e-compass applications. The BMM150 can be used in
combination with the BMI160 for 9-axis sensing. Placing a magnet near the sensor increases the sensor
output. The BMM150 is connected to the BMI160 as a secondary I?C device, and all of its sensor data is
passed to the BMI160 to be reported out over an I°C- and SMBus-compatible, 2-wire serial interface. The
reference designator for the BMM150 is U5.

More information on the BMM150 geomagnetic sensor can be found at https://www.bosch-
sensortec.com/products/motion-sensors/magnetometers-bmm150/.

Table 6. BMM150 Pinout

BoosterPack™ Plug-in Module - .
Header Connection T T
J1.8 BMM150 INT

2.2 Power
The board is designed to be powered by the attached LaunchPad development kit.

2.21 LaunchPad™ Development Kit Default Power
Power is provided through the 3V3 (J1.1) pin on the BoosterPack plug-in module headers. The 3V3 pin
powers everything on the BASSensors BoosterPack plug-in module.

2.3 Design Files

2.3.1 Hardware
Schematics can be found in Section 5. All design files including schematics, layout, bill of materials
(BOM), Gerber files, and documentation are available on the BP-BASSENSORSMKII Hardware Design
Files on the download page.

2.3.2 Software
All design files including software example projects, and documentation are available in the software
folders that are specific to each LaunchPad development kit.

2.4 Hardware Change Log
Table 7 lists the hardware revision history.

Table 7. Hardware Change Log

PCB Revision Description
Rev 1.0 Initial release
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3 Software Examples

The following software examples are included with the Sensor and Actuator Plugin for SimpleLink MCU
SDKs (see Table 8). These examples can be found in the SIMPLELINK-SDK-SENSOR-ACTUATOR-
PLUGIN , which is commonly installed as C:\ti\sail. Note that the SimpleLink SDK for your MCU must be
installed alongside the SAIL plugin. Within the sail folder, the software examples are located in
examples/rtos/[LaunchPad]/sail/. The software examples are compatible with the following LaunchPads:

+ CC1310_LAUNCHXL

+ CC1352R_LAUNCHXL
+ (CC2640R2_LAUNCHXL
+ (CC3220S_LAUNCHXL
+ CC3220SF_LAUNCHXL
+ MSP_EXP432E401Y

+ MSP_EXP432P401R

Table 8. Software Examples

LaunchPad™ /
Demo Name BoosterPack™ Description More Details
Required

. . | Samples voltage from DRV5055-Q1 using MCU

adcdrv5055 Séﬂ%g'&'&ggggl\/ﬂgﬁ Onboard ADC, convert voltage to milliTesla and Section 3.1
report using UART.

. SimpleLink MCU / BP- | Sample data from HDC2080 using 12C, convert )
i2cHDG2080 BASSENSORSMKIl | to temperature/humidity and report using UART, | Section 3.2
. SimpleLink MCU / BP- | Sample data from OPT3001 using 12C, convert .
12copt3001 BASSENSORSMKIl | 1o lux and report using UART. Section 3.3
. SimpleLink MCU / BP- | Sample data from TMP117 using 12C, convert to )
i2cTMP117 BASSENSORSMKII temperature and report using UART. Section 3.4

. . Sample data from BMI160 and BMM150 and
. . SimpleLink MCU / BP- : .
i2cbmi160 BASSENSORSMKII SX%[FQ DoF (Degrees of Freedom) data using Section 3.5

To use one of the software examples with the LaunchPad development kit, the user must have an
integrated development environment (IDE) that supports the SimpleLink MCU devices (see Table 9).

Table 9. IDE Minimum Requirements

Code Composer Studio™ IDE

IAR Embedded Workbench® for ARM® IDE

ARM® Keil® pVision® IDE

v7.1.0

v7.80.3

MDK-ARM v5

For more details on how to get started quickly, and where to download the latest CCS, IAR, and Keil IDEs,

see Section 4.
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3.1 DRV5055-Q1 Software Example
This section describes the functionality and structure of the adcdrv5055 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/adcdrv5055
3.11 Source File Structure
The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.
Table 10. Source File and Folders
Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software
tirtos/ace CCS project files used for importing this Software Example into Code Composer Studio software
g using the gcc compiler
tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
Contains MainThread for RTOS application and function which queries ADC connected to
adcdrv5055.c DRV5055-Q1
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README .html Information about using and running the example software
10 BP-BASSENSORSMKII user's guide SLAU829-May 2020
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3.2 HDC2080 Software Example

This section describes the functionality and structure of the i2cHDC2080 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cHDC2080

3.2.1 Source File Structure

The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there

instead.
Table 11. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software
tirtos/gce CC_S project files us_ed for importing this Software Example into Code Composer Studio software

using the gcc compiler
tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2cHDC2080.c Contains MainThread for RTOS application and function which queries HDC2080 using 12C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software
SLAU829-May 2020 BP-BASSENSORSMKII user's guide 11
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3.3

3.3.1

OPT3001 Software Example

This section describes the functionality and structure of the i2copt3001 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2copt3001.

Source File Structure

The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS

shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.

Table 12. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software
tirtos/gce CC_S project files us_ed for importing this Software Example into Code Composer Studio software

using the gcc compiler
tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2copt3001.c Contains MainThread for RTOS application and function which queries OPT3001 using 12C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software
12 BP-BASSENSORSMKII user's guide SLAU829-May 2020

Submit Documentation Feedback
Copyright © 2020, Texas Instruments Incorporated


http://www.ti.com
http://www.ti.com/feedbackform/techdocfeedback?litnum=SLAU829
http://www.ti.com/tool/download/SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN

13 TEXAS
INSTRUMENTS

www.ti.com Software Examples
3.4 TMP117 Software Example

This section describes the functionality and structure of the i2cTMP117 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cTMP117.

3.4.1 Source File Structure

The project is split into multiple files (see Table 11). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there

instead.
Table 13. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software
tirtos/gce CC_S project files us_ed for importing this Software Example into Code Composer Studio software

using the gcc compiler
tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i2cTMP117.c Contains MainThread for RTOS application and function which queries TMP117 using 12C
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software
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3.5 BMI160/BMM150 Software Example
This section describes the functionality and structure of the i2cbmi160 demo that is included in the
SIMPLELINK-SDK-SENSOR-ACTUATOR-PLUGIN. The example files are located in
ti/sail_x_xx_xx_xx/examples/rtos/[LaunchPad]/sail/i2cbmi160.
3.5.1 Source File Structure
The project is split into multiple files (see Table 14). This makes it easier to navigate and reuse parts of it
for other projects. On select LaunchPads, FreeRTOS examples are available in addition to the TI-RTOS
shown here. Look for the freertos folder adjacent to the tirtos folder and reference the files inside there
instead.
Table 14. Source File and Folders

Name Description
tirtos/ccs CCS project files used for importing this Software Example into Code Composer Studio software
tirtos/ace CCS project files used for importing this Software Example into Code Composer Studio software

g using the gcc compiler
tirtos/iar IAR project files used for importing this Software example into IAR Embedded Workbench
i26bmi160.c %)gtains Main thread for RTOS application and function which queries BMI160 and BMI150 using
i2cbmi160_support.c Support driver for communicating with the BMI160 and BMI150.
Board.h Definitions for this LaunchPad development kit and BoosterPack plug-in module combination
[LaunchPad].c Initialization for the selected LaunchPad development kit
[LaunchPad].h Definitions for the selected LaunchPad development kit
ccfg.c Customer Configuration file
README.html Information about using and running the example software
14 BP-BASSENSORSMKII user's guide
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4 Additional Resources
4.1 Tl LaunchPad™ Development Kit Portal
More information about LaunchPad development kits, supported BoosterPack plug-in modules, and
available resources can be found at:
« TI's LaunchPad portal: Information about all LaunchPad development kits from T, for all
microcontrollers
4.2 TI Cloud Development Tools
TI's Cloud-based software development tools provide instant access to SimpleLink SDK content and a
web-based IDE.
4.21 Tl Resource Explorer Cloud

TI Resource Explorer Cloud provides a web interface for browsing examples, libraries, and documentation
found in the SimpleLink SDK without having to download files to the local drive (see Figure 4).

Learn more about Tl Resource Explorer Cloud at https://dev.ti.com/.
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Figure 4. Tl Resource Explorer Cloud
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4.2.2 Code Composer Studio™ Cloud IDE

Code Composer Studio Cloud (CCS Cloud) IDE is a web-based IDE that lets you quickly create, edit,
build, and debug applications for the LaunchPad development kit (see Figure 5). There is no need to
download and install large software packages. You simply connect the LaunchPad development kit and
begin. The user can choose to select from a large variety of examples in the SimpleLink MSP432 SDK
and Energia or develop their own application. CCS Cloud IDE supports debug features such as execution
control, breakpoints, and viewing variables.

A full comparison between CCS IDE Cloud and CCS Desktop is available here.
Learn more about Code Composer Studio Cloud IDE at https://dev.ti.com/.
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13
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tting PC to entry point.
and running...

Figure 5. CCS Cloud
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4.3 Code Composer Studio™ IDE

Code Composer Studio IDE Desktop is a professional integrated development environment that supports
TI's microcontroller and Embedded Processors portfolio. Code Composer Studio IDE comprises a suite of
tools used to develop and debug embedded applications. It includes an optimizing C/C++ compiler, source
code editor, project build environment, debugger, profiler, and many other features.

Learn more about CCS IDE and download it at www.ti.com/tool/ccstudio.

CCS IDE v6.1 or higher is required. When CCS has been launched, and a workspace directory chosen,
use Project>Import Existing CCS Eclipse Project. Direct it to the project directory that contains the main.c

of the desired demo (see Figure 6).
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ory of the projects to impart

]

F ]
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4| | QutQfBox_MSP430FRA93S

) CCs
J driverlib
J TAR

Folder:

Make Mew Folder [ CK

OutOfBox_MSP430FRETET

H Cancel I

e

Figure 6. Directing the Project>Import Function to the Demo Project

The user can also select the \CCS subdirectory. The CCS-specific files are located there.

When the user clicks OK, the CCS recognizes the project and allows the import.
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4.4

The project appears in the Import CCS Eclipse Projects window and has a checkmark to the left of it if the
CCS found the project (see Figure 7).

v Import CCS Eclipze Projects I. =] &J
Select CC5 Projects to Import %
Select a directory to search for existing CC5 Eclipse projects. / 5

@ Select sgarch-directery:  Examples'Source\ QutOfBox_MSP430FRG589 Browse...

) Select archive file: Browse

Discovered projects:

r OutOfBox MSP430FRESES [C:htin SLACESTYMSP-EXPA30FRESES Select All

Deselect All
¢ m 3 Refresh

Automatically import referenced projects found in same search-directory

Copy projects into workspace

Open the Resource Explorer and browse available example projects...

':\7?' Finish ] I Cancel

Figure 7. When CCS Has Found the Project

Sometimes the CCS IDE finds the project but does not show a checkmark. This may mean that the
workspace already has a project by that name. The user can either rename or delete that project to fix this
issue. If the project does not appear in the CCS IDE workspace, make sure to check the workspace
directory on the file system.

IAR Embedded Workbench® for TI MSP430™ MCUs

IAR Embedded Workbench for MSP430™ MCUSs is another very powerful integrated development
environment that allows you to develop and manage complete embedded application projects. IAR
Embedded Workbench integrates the IAR C/C++ Compiler, IAR Assembler, IAR ILINK Linker, editor,
project manager, command line build utility, and IAR C-SPY® Debugger.

Learn more about the IAR Embedded Workbench for MSP430 MCUs and download the software at
www.iar.com/.

IAR 6.10 or higher is required. To open the demo in IAR, click File>Open>Workspace..., and browse to
the *.eww workspace file inside the \IAR subdirectory of the desired demo. All workspace information is
contained within this file.

The subdirectory also has an *.ewp project file. This file can be opened into an existing workspace by
clicking Project>Add-Existing-Project....

Although the software examples have all of the code required to run them, IAR users may download and
install MSP430Ware™ software that contains MSP430 MCU libraries and the Tl Resource Explorer.
These are already included in a Code Composer Studio IDE installation unless the user selected
otherwise.
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4.5 Energia

Energia is a simple, open-source, and community-driven code editor that is based on the Wiring and
Arduino framework. Energia provides unmatched ease of use through very high-level APIs that can be
used across hardware platforms. Energia is a lightweight IDE that does not have the full feature set of
Code Composer Studio IDE or IAR Embedded Workbench IDE. However, Energia is great for anyone who
wants to get started very quickly or who does not have significant coding experience.

Learn more about Energia and download it at www.energia.nu.

4.6 SimpleLink™ MSP432 SDK, MSP430Ware ™ Software, and Tl Resource Explorer

The MSP432 device is part of the SimpleLink microcontroller (MCU) platform, which consists of Wi-Fi®,
Bluetooth® low energy, Sub-1 GHz, and host MCUs. All share a common, easy-to-use development
environment with a single core software development kit (SDK) and rich tool set. A one-time integration of
the SimpleLink platform lets you add any combination of devices from the portfolio into your design. The
ultimate goal of the SimpleLink platform is to achieve 100 percent code reuse when your design
requirements change. For more information, visit www.ti.com/simplelink.

For the 16-bit MSP430 MCUs, the MSP430Ware software package is used. MSP430Ware software is a

complete collection of libraries and tools. It includes a driver library (driverlib) graphics library (grlib), and
many other software tools. MSP430Ware software is optionally included in a Code Composer Studio IDE
installation or can be downloaded separately. IAR users must download it separately.

Both the SimpleLink MSP432 SDK and the MSP430Ware software are included in the Tl Resource
Explorer for easily browsing tools, documents, examples, and more (see Figure 8).
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Figure 8. Tl Drivers Software Examples in Tl Resource Explorer

Inside Tl Resource Explorer, these examples and many more can be found and easily imported into Code
Composer Studio IDE with one click.
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4.7 The Community

4.71 Tl E2E™ Online Community

Search the forums at e2e.ti.com for helping building your EVM boards. If you cannot find the answer, post
a question to the community.

4.7.2 Community at Large

Many online communities focus on the LaunchPad development kit and BoosterPack plug-in module
ecosystem like www.43oh.com. You can find additional tools, resources, and support from these
communities.
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Figure 9. Schematic
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